VDESK and REMO
USER GUIDE Version 6.3 (2018)

REMO UBEREMOTE

REMO ISOREMOTE

Table of Contents
VDESK and REMO Hardware Overview.........................................................................................................................1
Using Multiple Monitors .............................................................................................................................................1
Keyboard Shortcuts ....................................................................................................................................................3
Software Overview – the User Interface.......................................................................................................................4
Camera & Input Windows ......................................................................................................................................4
Preview Window ...................................................................................................................................................4
DSK Window .........................................................................................................................................................5
Playlist Window .....................................................................................................................................................5
File Browser Window .............................................................................................................................................5
Program Window...................................................................................................................................................5
Clock and Audio Windows ......................................................................................................................................6
Switcher Window ..................................................................................................................................................6
Settings Window ...................................................................................................................................................6
1 – Camera Windows .................................................................................................................................................7
2 – Preview Monitor & Control....................................................................................................................................8
3 – DSK Control Window .............................................................................................................................................8
4 – Playlist Window ....................................................................................................................................................9
5 – File Browser Window ............................................................................................................................................9
6 – Program Monitor ............................................................................................................................................... 10
Bug On/Off ......................................................................................................................................................... 10
Bug selection ...................................................................................................................................................... 10
Crawl 1 & 2 On/Off ............................................................................................................................................. 10
Enter Main Crawl… ............................................................................................................................................. 11
Displaying two crawls simultaneously................................................................................................................... 11
Text ................................................................................................................................................................... 11
Using HOT AUTO, HOT TAKE, and HOT KEY buttons ............................................................................................... 12
7 – Clock & Audio Window ....................................................................................................................................... 12
8 – Switcher Control Window ................................................................................................................................... 13
Clip End Actions: ................................................................................................................................................. 13
Transitions and Effects tabs: ................................................................................................................................ 13
9 – Settings Panel - Info ........................................................................................................................................... 14
9 – Settings Panel – Audio ........................................................................................................................................ 14
9 – Settings Panel – Encode ..................................................................................................................................... 14
Preparing for a Production ....................................................................................................................................... 16
Setting and Saving PTZ Camera Presets ..................................................................................................................... 16
Creating a Graphic .................................................................................................................................................. 17
Linking a Graphic to a Camera Preset ........................................................................................................................ 17
Saving Your Layout .................................................................................................................................................. 18
Creating a Playlist.................................................................................................................................................... 18
Selecting Transitions ............................................................................................................................................... 18
Selecting and Using EFFECTS .................................................................................................................................... 19
To display a Picture in Picture … (PiP) ....................................................................................................................... 19
To display a Double Box PiP … .................................................................................................................................. 20
Working with Chroma Key ....................................................................................................................................... 20
Setting up a Recording............................................................................................................................................. 21
Adjusting System Configuration ............................................................................................................................... 21
Configure CRAWL parameters .................................................................................................................................. 22
Monitoring & Controlling Audio Levels ..................................................................................................................... 23
Working with Dynamic Auto Zoom ....................................................................................................................... 24
Starting your Production.......................................................................................................................................... 25
Don’t forget to start recording! ................................................................................................................................ 25
Adobe Elements and VDESK / REMO......................................................................................................................... 27
PRODUCER Overview: Staging an Event .................................................................................................................... 28

The STAGE tab ........................................................................................................................................................ 29
The CAST tab .......................................................................................................................................................... 30
The PLACES tab ....................................................................................................................................................... 31
Changing the SIZE of display picons ...................................................................................................................... 31
Adding EXTRAS to the STAGE layout ..................................................................................................................... 31
The CAMERAS tab ................................................................................................................................................... 32
The PRESETS tab ..................................................................................................................................................... 32
To create a preset for a CAST member or EXTRA … ................................................................................................ 32
Enabling and Using DoubleTake™......................................................................................................................... 33
Setting up the DoubleTake offset ......................................................................................................................... 33
Saving PRESETS to the QUICKSHOT Button Bar ...................................................................................................... 34
Switcher Functions on the QUICKSHOT Button Bar ................................................................................................ 35
Showing the SWITCHER and PREVIEW Windows ................................................................................................... 35
Showing the AUDIO MIXER .................................................................................................................................. 35
Using the DSK control ......................................................................................................................................... 35
The following sections are included on pages in the CLASSIC section of the USER GUIDE: ......................................... 35
Selecting Transitions ........................................................................................................................................... 35
RUSHWORKS Contact & Support Info ................................................................................................................... 36

VDESK & REMO Touch Screen Production Systems
USER GUIDE Version 6.3

(2018)
Features and functions are being added continually, and this Guide will be updated frequently.
As a result, the content herein may not reflect the current feature set and behavior of the application.

Your RUSHWORKS Integrated Television Production System is designed specifically to enable a single operator to
produce highly professional, multi-camera shows … with NO CAMERA OPERATORS REQUIRED! Name and save PTZ
presets; create and display graphics and playlists; use multiple layers of crawls, logos and animation; use Chroma-key for
virtual sets and backgrounds; encode to internal storage, stream LIVE, and much more. This Guide will cover all the
components and controls included with your VDESK or REMO system.

VDESK Hardware Overview
Your VDESK Touch Screen Production System includes several components:
STANDARD
1. 24" touch screen monitor
2. Custom keyboard with shortcut keys
3. Mouse
4. 6 button Hall effect joystick
5. Computer
6. MUX box – serial camera control and power*
7. DEMUX breakouts – one for each PTZ camera/PTX when MUX is provided*
8. Camera cable – CAT5 and SDI-rated RG6 coax

REMO Hardware Overview
Your REMO Touch Screen Remote Production System includes several components:
REMO UBEREMOTE 4
1. Lightweight ruggedized portable computer with 15.6”touch screen monitor
2. 6 button Hall effect joystick, custom keyboard, 1 x MUX and 4 x DEMUX
REMO ISOREMOTE 8
3. Portable ruggedized computer with SKB rolling case and 15.6” or 23” touch screen monitor(s)
4. 6 button Hall effect joystick, custom keyboard, 2 x MUX and 8 x DEMUX

Using Multiple Monitors
On VDESK and REMO systems you can connect a second monitor to display additional camera controls … or for working
with parallel applications like the included Adobe Photoshop Elements for immediate creation or editing of on-screen
graphics. You can also use the included Adobe Premiere Elements to edit your productions after they’re encoded.
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Custom Keyboard Shortcuts

A custom keyboard with color-coded shortcuts is provided with your VDESK and REMO system. For an overview we’ll
start at the top left and move down the main keyboard, then over to the arrow keys and number pad.

KEYBOARD

KEYPAD

RED PGM1 – PGM9 and BLACK: Click these to select the corresponding
switcher input to the PROGRAM window/output

GREEN CAM 1/5 – 4/8: Click once to select inputs 104 on the Preview
panel. Hold Shift and press keys to select inputs 5-8

GREEN PVW1 – PVW9 and BLACK: Click these to select the
corresponding switcher input to the PREVIEW window

YELLOW Number Pad (1-9): Select the corresponding Preset for the
currently selected Preview camera

RED PROGRAM TAKE: Cuts to the current selection on the Preview
panel. This action reverses the PGM/PVW selections on the switcher

RED PGM AUTO (+): Dissolves from the PGM input to the PVW input

YELLOW TILT UP (Home): Tilt PTZ/PTX camera UP

RED PGM TAKE (Enter): Cuts from the PGM input to the PVW input

YELLOW TILT DN (End): Tilt PTZ/PTX camera DOWN

BLUE File Brower (Insert): Selects File Browser window

YELLOW PAN L (Delete): Pan PTZ/PTX camera LEFT

BLUE Playlist (Insert): Selects Playlist window

YELLOW PAN R (PgDn): Pan PTZ/PTX camera RIGHT
YELLOW ZOOM (PgUp): Zoom PTZ/PTX camera IN
Shift+ZOOM zooms OUT (also Insert key)
BLUE LIST (Up arrow): Select previous item (Playlist or File Browser)
BLUE LIST (Down arrow): Select next item (Playlist or File Browser)
BLUE DSK AUTO (Left arrow): DSK AUTO (fade ON or OFF)
BLUE DSK TAKE (Right arrow): DSK TAKE (cut ON or OFF)

KEYBOARD CAMERA PRESET SELECTIONS
Q = Preset 1
W = Preset 2
E = Preset 3
R = Preset 4
A = Preset 5
S = Preset 6
D = Preset 7
F = Preset 8
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Software Overview – the User Interface
After powering up the system, run the VDESK software by clicking on the VDESK or REMO
launch icons on the desktop. After a few seconds the User Interface will appear.
The user interface has different windows for controlling different functions:

Initial Setup:
If it is the first time you have run the
application … and you have PTZ cameras
connected … you will need to configure
your cameras. Just select your model
from the list on each port for the correct
number of cameras you have.

1 - Camera & Input Windows
On the left side of the screen you will find CAMERA CONTROL windows. The
/v

default number of camera windows displayed is four (4), but can be customized by
an entry in the Config panel. The maximum number of inputs (PTZ or standalone
cameras or other devices) supported by the system is twelve (12). The inputs can
be configured for SDI and/or HDMI input signals. Non-camera inputs are used for
network sources such as NDI, Facebook, YouTube, etc.
All camera windows function the same, but each controls a different camera. The
camera output image displays in the window to the left of the presets. There are
eight (8) presets available per camera.

2 - Preview Window
To the right of the first camera window is the PREVIEW
window. This shows which camera (or clip) is currently on the
preview bus of the switcher. It also lets you preview and cue
up clips by using the motion controls.
VDESK / REMO - User Guide Version 6.3 - 2018
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3 - DSK Window
Below the PREVIEW window is the DSK window, which displays
and controls images with transparency – usually PNG files.
This window has two sections, the DSK Preview and the DSK
Program. This allows you to preview images while having
another image on-the-air. When the DSK Program is illuminated
("ON AIR") the image in that monitor will display on the main
PROGRAM output monitor.

4 - Playlist Window
At the bottom of the screen is the PLAYLIST window. This is where
you save an ordered list of files for playback. Just drag and drop files
from the File Browser to create and Save as many lists as you wish.
Select and drag any item anywhere within a list to reorder the
contents. Buttons are provided to change from Text View to Icon
view.

5 - File Browser Window
To the right of the Playlist window is the FILE BROWSER window. This
window allows you to browse for media on your system and select it
for display. Quick access shortcuts are included for preset folders CGs, Clips, Pics, and All - to help keep your media organized. Clips and
Pics display in the PREVIEW window; CGs (typically ‘lower thirds’ with
transparency, i.e. PNG files) display in the DSK window.

6 - Program Window
On the upper right of the screen, next to the audio meters and
clock, is the PROGRAM window. This window displays the
main output of your system. On the left side of the video
display is an icon bar with one-touch display buttons for
monitoring Program or Preview audio; displaying a branding
logo (BUG); displaying TWO independent crawls; one animated
graphic (‘snipe’), currently loaded clip location and duration;
and HOT SHOT controls (toggle on/off) that automatically
TAKE or TRANSITION to a selected camera preset.
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7 - Clock and Audio Windows
To the right of the Program window are the CLOCK and
AUDIO windows. They display the current time, a
counter, and the level of the system's audio output. The
slider is used to adjust the master volume. There is also
a mute button which will completely silence any audio
output.

8 - Switcher Window

Below the Program Monitor is the SWITCHER window, displaying four, eight or
twelve inputs based on your system configuration. This controls which input is
sent to the program output. It also has menu selections for effects and
transitions. There are two file/clip players used to display video clips and
graphics files. When active the player number and status are displayed on the
PGM (red) and PVW (green) buses. The T-Bar is available for manual transition
control.

9 - Settings Window
At the bottom right of the screen you will find the SETTINGS
window. It has multiple sections for changing various
settings of the system. There are tabs that open controls for
(a) encoding and streaming your output, and (b)
setting/mixing LIVE input level and clip playback levels.
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1 – Camera Windows

With a four-input configuration there are four camera windows, typically connected to inputs 1-4 on the switcher. The
title bar indicates the camera number, and changes color based on the on air status of the camera. Red indicates the
camera is on Program. Green corresponds to the camera that is on Preview. Gray is any camera that isn't on Program or
Preview, and Black is a camera that is disconnected or doesn't have PTZ control.
Each window has an overlay of the video coming from the corresponding camera. Moving the cursor to the video will
highlight it with a border. This will allow you to manually control the pan and tilt of the camera with the mouse (or with
your finger on the touch screen if you wish). Below the video feed are controls for FOCUS, AE REF and IRIS. When A is
selected next to the right rocker switch, AE Reference is active. When M is selected, manual Iris is active.
Beneath the video window are the Preset Buttons. Each one can be programmed with a unique shot including any of the
controllable functions of the camera and stored with a descriptive name you enter. Below the 8 preset buttons are
several controls that enable sophisticated camera operations. The SPEED slider lets you select the speed that the camera
will move from its current position to the stored preset you select.
NOTE: For enhanced production value, put “cameras in motion” using either or both the Dynamic Auto Zoom feature and
the Motion Transition functions.
Example: Set one of your primary cameras for DAZ, so that it’s constantly doing a very slow zoom in and out. When going
from the camera (PGM bus) to another camera preset (PREVIEW bus), select a relatively slow SPEED slider selection on
the destination camera and hold down the Ctrl key while you select a preset. The switcher will CUT to that camera once it
starts zooming. If you hold down the Shift+Ctrl keys and click a preset, the switcher will use the currently selected
TRANSITION to that camera.
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2 – Preview Monitor & Control

The Switcher Preview window shows a video preview of the source selected on the Preview output of the switcher. This
may be one of the PTZ cameras, another video input, or a preview of your clip playback or selected still graphic, if that
graphic has no transparency. Typically BMP and JPG files do not support transparency. PNG files are most commonly
used with transparency for ‘lower third’ titles and other instances where graphics are superimposed over a video source.
When a clip is selected in the Playlist or File Browser it automatically appears in the Preview window and the appropriate
transport controls will activate. The audio speaker icon indicates whether or not the clip has audio present. Clicking the
icon will enable or disable the audio playback. The transport controls allow you to preview the clip, or cue the desired
spot from which to start playback when the clip is selected for display on the PROGRAM output. When a “LIVE” input is
selected the motion controls are disabled.

3 – DSK Control Window

The DSK window has controls for putting your graphics and video files on air. The monitor lets you preview graphics, and
then fade or cut them over the PROGRAM video. When you click a graphic to display it in the DSK PROGRAM section, you
can preview other graphics while the original is still on-the-air. Clicking "Auto to Air" or "Take to Air" will fade out the
graphic from the PROGRAM window then fade in the second graphic from PREVIEW. Whenever a graphic is being
displayed in the ON AIR DSK PGM window, ir you can FADE it off or TAKE it off using the respective buttons below the ON
AIR light in the PROGRAM section.
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4 – Playlist Window
The Playlist window is used to create an
ordered list of files for playback during
your production. You can add files to the
Playlist by dragging them over from the
File Browser or by clicking on the Add
button and selecting them using the
Windows dialog. With a file selected,
simply click the TAKE to AIR or AUTO to
AIR button on the DSK window to display
it in the PROGRAM window.
As in the File Browser window, files can
be displayed as a simple text list or as
thumbnails using the Icon View. The
remaining buttons along the bottom (in
order from left to right) Move a file (or
files) up and down the list one step per
click, Add a file to the list, and Delete a
file from the list. The bottom right features a button for creating a New playlist, one to Open an existing playlist, another
to Save the current playlist, and another to Save the current playlist under a new name - Save As.

5 – File Browser Window

The File Browser window can be used for searching your hard drive to locate files to add to your playlist. You can also
play and display files directly from the File Browser simply by clicking on them and then clicking the TAKE to AIR or AUTO
to AIR button on the DSK window.
Files can be displayed as a simple text list or as thumbnails using the Icon View. The buttons along the bottom control
that view, as well as allowing you to open a Windows dialog to browse for a different folder, move up to the parent
folder, and filter the current folder's contents. There are also four category buttons to take you to the default CGs, Clips,
Pics, and All folders.
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6 – Program Monitor

The Program window shows the video output of the system. It is the final composited video signal that the system is
producing. This is also what will be captured by the encode function.
The PVW/PGM audio monitoring switch allows you to monitor either PROGRAM audio or PREVIEW audio. Clicking on it
will toggle between the options. GREEN headphones indicate you are monitoring PREVIEW through the computer audio
jack output … and RED headphones indicate you are monitoring PROGRAM audio output – the same that is being output
on the balanced XLR outputs or SDI embedded output of your system.

Bug On/Off
You can display a BUG (usually a ‘branding graphic’)
at any time by left-clicking once on the BUG icon. It
will illuminate (glow RED) and the currently selected
graphic, usually a PNG file, will fade on. Click again
to deselect the BUG. The icon will be grayed out,
and the currently displayed graphic will fade off.

Bug selection
To select the graphic associated with the BUG, right-click on the BUG
icon. Choose Select Logo Bug … A browser window will open, revealing
the contents of the CGs folder. Select the desired graphic and click OK.
When you next left-click the Bug icon to activate it, the attached graphic
will fade on.
Reset Logo Bug … removes the current bug file association, so nothing
will be displayed with you click the Bug icon.
Open File … opens the currently associated Bug graphic
for verification.

Crawl 1 & 2 On/Off
To display crawl text associated
with Crawl 1 (Main Crawl), left-click
on the Crawl 1 icon. Any text entry
currently stored for Crawl 1 will
immediately display on the Program
VDESK / REMO - User Guide Version 6.3 - 2018
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Enter Main Crawl…
To enter crawl text associated with Crawl 1 (Main Crawl), right-click on the Crawl 1
icon. Select Edit Main Crawl … Enter the text you want to display in the Main Crawl …
and enter the number of repetitions of the crawl message you want to display (1-50) …
or enter 0 to crawl continuously until you manually click on the Crawl 1 icon on the
Program Display to deactivate it.

Choose the Reset Crawl option to clear the currently entered crawl text, and
then click OK.

Displaying two crawls simultaneously
Since the two crawls are independent, when you left-click either Crawl 1 or Crawl
2, the crawl begins immediately, following the repetition rule you create in the
Main Crawl Properties.
Crawl set up properties include font, font size, font color, background color,
transparency, and speed.

Text
You can enter a text message directly for display by right clicking the
Text icon and selecting Edit Text …

The Edit TEXT Properties window will open. You can enter text
directly in the text box, with your input displayed in real-time in
the Video Preview window. The text wraps automatically, based
on the Title Safe margins defined in the Advance Mode settings.
You can also select a Backgrouand Image to use behind the text. If the image
supports transparency (PNG), the text will be composited over the
background, revealing the portions of the PGM image.

Another common use of the Text display is to put a Time and Date
identifier on the screen. Just check the Add Time and Date checkbox
and that information will automatically display on the PGM output.
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To set up all the display
parameters of the Text
display, click on
Configure in the Edit
Menu (or on the
VDESK info screen in
the lower right).
Here you’ll select the font,
style, size, alignment, and
color. Also select where you
want to display it on the
screen, as well as the format
of the Date and Time display.

Using HOT AUTO, HOT TAKE, and HOT KEY buttons
The three HOT buttons provide enhanced automation of putting your selected preset
shots on the Program output … as well as fading on any graphics associated with PTZ
camera preset selection. HOT KEY only applies if you have created links to graphics
for any of your presets (see “Linking a Graphic to a Camera Preset” on page 15).
Toggle on/off either the AUTO or TAKE buttons. They will ‘illuminate’ when
active/on. Whenever you select a “linked” camera preset, the system will
automatically switch to that shot as soon as the camera reaches the preset
destination, “cutting” to the shot if TAKE is On/illuminated … or dissolving to the
shot if AUTO is on/illuminated.
With HOT KEY OFF, the system will automatically load the associated graphic into the
DSK PVW window, where you can manually use the Take to Air or AUTO to Air to
fade on that graphic over the PROGRAM video.
With HOT KEY ON, the associated graphic will automatically fade on after the HOT
AUTO or HOT TAKE is executed. Right-click the HOT KEY toggle to display userdefined settings for how many seconds it’s delayed before it fades on … and for how
long it displays before it fades out.

7 – Clock & Audio Window
The clock window has an analog clock showing the current time. It also includes a
digital clock and timer. To start the timer, simply click the button labeled "Click for
Timer" and it will start counting up seconds. To stop the timer, touch the display. To
start again, touch the display again. The "Reset" button will reset the display to
zero.
The Audio Window shows the real time master levels of your VDESK or REMO
system. These levels reflect what the system is outputting on the master audio
output as well as what is being captured by the encode function. The Slider will
adjust the mixed output of all the audio sources. The Mute button will mute the
audio output of the system. The Close and Minimize controls on the clock panel
affect the entire program. You can also exit VDESK by right-clicking any of the
camera window title bars and choosing "Exit"
VDESK / REMO - User Guide Version 6.3 - 2018
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8 – Switcher Control Window

The Switcher controls what input is on the Preview and Program bus. You can change inputs one of 3 ways:
1. Use the AUTO button - this will change between the Program input and the Preview input using currently
selected transition and duration.
2. Use the TAKE button - This will cut from the Program input to the Preview input.
3. Direct selection - Click any of the input buttons on either bus to switch the corresponding bus to that input.

Clip End Actions:
These allow you to control what happens when a clip on program reaches the end. The control is located above the CLIP1
and CLIP2 buttons on the switcher. When you click on the text it will cycle though the four choices, and when you click on
the down arrow it will display a menu:

Black at Clip End - Once the clip runs out you will see black until you choose another input on the switcher.
Take at Clip End - Upon reaching the end of the clip the system will perform a TAKE command, switching to the preview
input.
Auto at Clip End - At the end of the clip the system will perform a dip to black transition.
Repeat at Clip End - The clip will repeat until another input is selected. This option lights up RED as a reminder - the clip
will keep looping endlessly unless you stop it!

Transitions and Effects tabs:
The Transitions and Effects tabs are where you select the type of transition, duration of that transition,
and effect options. Not all effects and transitions have the same options so each selection will look
different.
For more information on how these work, jump ahead to Choosing Transitions & Effects.
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9 – Settings Panel - Info
The Settings window defaults to the VDESK panel.
This displays the product logo, Help File button, and
software version. It also has tabs to access the
other settings panels – Audio and Encode.

10 – Settings Panel – Audio
Another panel available from the Settings window is the Audio panel. This
allows individual adjustment of the LIVE input, CLIP1, CLIP2 and Snipe audio
playback levels. When you select a video clip for playback it appears in the
Preview window and the corresponding channel is indicated in GREEN.
When a clip is on Program the corresponding channel shows in RED. The
buttons on the switcher will correspond in color to the CLIP1 and CLIP2
indications on the audio panel.

9 – Settings Panel – Encode
The Encode panel displays the settings for recording. The first
is the Encoding Path which where your files will be stored. By
default this is set to D:\Recordings. If you wish to change this
use the Browse button to select the desired folder. Below that
is the optional File Name which will be used as the prefix to
your file name. The file name will always be created in this
format: filename yyyy_mmss hhmmss.

You can encode two (2) independent file formats, H.264 and MPEG-2. When you click the RECORD button, you’ll see the
status of the recording on the left, displaying the format and the amount of time it has been encoding.
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You can click the PAUSE button at any time. The RECORD button will
indicate the encoding is paused. Click the yellow RESUME button whenever
you’re ready to resume encoding. The resulting files will be contiguous, with
seamless splicing at the pause/resume point(s).

If recording space drops below one hour you will see a box pop up alerting
you. A warning will show again at 5 minutes remaining. Recording will STOP
AUTOMATICALLY when no more space is available. Please keep this in mind
when starting a recording.
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Preparing for a Production
Now that you have had a brief overview of each window that makes up the user interface, we’ll show you how to set up
for production.
The “How To” steps we will cover are:
1. Create and name your camera presets.
2. Create graphics for your production.
3. Link a camera preset to a graphic.
4. Create a playlist.
5. Set up a recording.
6. Adjust the system settings.
Once these things are done you are ready to start your production.

Setting and Saving PTZ Camera Presets
There are a few different ways to control the PTZ
cameras. The joystick and touch pads are the most fluid,
but you can also use the keys above the arrow keys to
adjust camera positions. The joystick and keyboard
controls will always apply to the camera currently
selected on PREVIEW. This allows you to move the
camera to the position or preset you desire without a
rapid on-air move.

These include:
Zoom Out
Zoom In
Tilt Up
Tilt Down
Pan Left
Pan Right

Use the joystick to position the shot using Pan, Tilt and Zoom - then right-click the desired preset button on the
corresponding camera window. This will open a context menu for managing presets.
Rename and Store Preset...
Opens a dialog to edit the name of the preset and save all the
camera parameters that have been set
Store Preset
Saves the current camera state to that preset (does not
change name)
Rename Preset...
Opens a dialog to edit the name of the preset
Link Preset to DSK Overlay
Opens a dialog that allows you to select a graphic (PNG file) to
link with the preset. Each time you go to that preset the linked
file will be loaded in the DSK window
Go To Preset
Moves the camera to that preset
Copy Preset
Saves all the associated positioning and camera data.
Copy All Presets
Saves all the positioning and camera data for all presets.

Paste Preset
Pastes the copied positioning and camera data.
Paste All Presets
Pastes all the positioning and camera data to presets on
another camera.

Clear Preset
Clears all data from the selected preset.
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All camera data is saved to a preset. If Auto is the selection on the individual camera control, then that camera will be in
the automatic focus and exposure mode for that preset. If you desire to set focus, exposure, and white balance
manually, all these can be saved to each preset as well.
Select Rename and Store Preset … and enter a descriptive name for that shot, e.g. MAYOR, PASTOR, DRUMS, PIANO, etc.
Now that you’ve named and saved your first preset, follow the same procedure to name and save up to nine (9) presets
per camera. It's a good idea to get multiple angles of the shots that will be used most so that you can easily switch to
another if there is an obstruction. That is accomplished by creating similar presets on other cameras, so it’s OK to have a
preset called MAYOR on more than one camera. Use manual focus or iris if you have certain shots where focus and
lighting don’t produce good results using the default AUTO settings for a preset.

Creating a Graphic
To speed up the creation of “lower thirds” and title
screens for your productions we have included Adobe
Photoshop Elements and Adobe Premiere Elements on
your system. To start the desired program either click the
pse or pre icon on the desktop, or the corresponding icon
on the quick launch bar. Photoshop is for creating static
images and overlays, Premiere is used to create animated
full screen graphics and edit your captured footage if you
wish. We’ll begin by creating a PNG to use as a lower third.
Launch Photoshop Elements.
Note: if you chose to create your own graphics they must be on pages corresponding to your selected output format
(480i, 720p, 1080i or 1080p). These are, respectively, 720x480, 1280x720, and 1920x1080.

Once the program is running go to File > Open and then browse to D:\Media\CGs\Templates and chose one to work
with. Shown above is the file named DarkBar_Lower3rd_template.psd. It has a shape layer and a text layer. To edit the
text select the T (Text Tool) from the tool bar on the left side of the screen and move it over the text you wish to change.
The shape layer has a gradient effect and a drop shadow. To edit these, double-click on the fx icon in the Layers pallet on
the right side of the screen. There are many effects you can use to create depth or stylize your images. The templates are
all write-protected, so experiment and have some fun! The originals will be there to work with if you don't like what you
have changed.
After you have edited the text and created something you wish to use, click File > Save As... and chose.png from the file
type pull down. If you save the file in the D:\Media\CGs folder you will have fast access to it with the CGs shortcut button
in the File Browser window. Name the file something that will help you remember what it contains, and click Save.

Linking a Graphic to a Camera Preset

from the list.

Once you have a camera position saved to a preset button you have the option to
link an overlay to it. These can be created in Photoshop Elements or another
graphics program you may have. Once these files are saved as.PNGs you can link
them. All you have to do is DRAG your PNG from the File Browser onto the preset
you want it linked to and then DROP it. It's that easy! If you want to do it the hard
way, you can right-click the desired preset and select Link Preset to DSK Overlay

HINT: If you hover over the link icon on a preset the tool tip will show you the name of the overlay linked to that preset.
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When this method is selected, an entry window will appear:
Check the box next to Link Preset to DSK
Overlay and then the Link... button and browse
to the graphic. Select it and hit Open, then hit
OK on the previous window. You should now
see the Chain Link icon. There are 3 states of
this icon:
This link icon means that the preset is linked to a PNG and it is enabled. It will be loaded every time the shot is
selected.
This link icon means that the preset is linked to a PNG and it is disabled. It will NOT be loaded when the shot is
selected.
This link icon means that the preset is linked to a PNG but the PNG can't be found.

Saving Your Layout
Once you have linked everything
you want be sure to save the
layout. To do this, right-click on
the camera title bar and select
Save Layout from the list.

Creating a Playlist
Creating a playlist for use during a
production is drag and drop simple!
Browse for the desired files using the File
Browser window and drag them over to
the Playlist window. You can use the
provided buttons to move items up and
down the list, or you can just drag them
to change the order. If you want to save
the playlist for later use, click the Save As
button at the bottom. Playlists can also
be created by importing an agenda from
CGPrep.
You can create and save as many Playlists
as you wish. Examples include City
Council (date), P&Z (date), 7AM Service
(date), 11AM Service (date), etc.
v
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Selecting Transitions
A video transition occurs between what the inputs currently selected on the Preview and Program busses.
When you click the AUTO button the image on Preview replaces the one currently on the Program output.
To view the available transitions, click the Transition tab and click the
down arrow to display the dropdown list. There are 20 transition
options to choose from. Dissolve is the default, and is typically the
most often used transition effect along with Cuts – which are
accomplished using the TAKE button or by selecting
various inputs on the virtual screen Program bus or
using the keyboard shortcuts.
The transition icons represent the type and
direction of entry of the selected transition.
You can also repeatedly click on the transition name button and it
will select and display the next transition in the order displayed on
the dropdown list.

Selecting and Using EFFECTS
Because the switcher has only a Program and Preview Bus … plus a DSK (Down Stream
Keyer) … the two busses are used to set up and display effects as well.
An “effect” is often called a “DVE” … or Digital Video Effect. This usually suggests the
placement and/or manipulation of smaller video windows inside the ‘main’ video window.
These types of DVE placements are referred to as “squeeze backs”, “PiP” … or Picture-in-Picture, “double box shots”, etc.
Click the Effects tab and click the down arrow to display the dropdown list.

To display a Picture in Picture … (PiP)
1) Select Picture in Picture in the dropdown list.
2) Click the desired size and position from the six available choices. You will see the
inputs currently assigned to the PiP window and the background it’s displayed over.
3) To check or change the current input assignments, use the PIP and BG dropdowns
to select available inputs for each. You’ll see your changes happen in the Preview
window in real-time.
Note: Each of the six PiP positions stores its own Foreground and Background input
settings. Because all transitions and effects are confined to what can be
accomplished using inputs on the PGM and PVW buss … plus the DSK … it’s important
to learn how to manage the setup required for optimizing your results when using
Effects in VDESK.
5) Click AUTO or TAKE to display the PiP effect on the Program screen.
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To display a Double Box PiP …

1) Select Double Box in the dropdown list.

2) Click the desired size and position from the seven available choices.
You will see the currently assigned inputs in the respective box position icons.
To change the current input assignments, use the L and R dropdowns.
4) Select the L (Left) input, the R (Right) input, and use the ellipsis button to search for a
Background Picture if you want to use one. You’ll see your changes happen in the
Preview window in real-time.
Note: Each of the seven Double Box positions stores its own Box L and Box R input settings.
Because all transitions and effects are confined to what can be accomplished using inputs
on the PGM and PVW buss … plus the DSK … it’s important to learn how to manage the
setup required for optimizing your results when using Effects in VDESK.
5) Click AUTO or TAKE to display the Double Box effect on the Program screen.

Working with Chroma Key
Creating a good, “clean” Chroma Key depends very much on the lighting. You need
“flat” lighting across your green/blue screen, and good fill and back/rim light on your
subject, for optimal results. But the Chroma Key function in VDESK is extremely
‘forgiving’, meaning you can generally create high quality green screen keying without
a lot of lighting … in some cases getting good results with simple overhead fluorescent
lights!
Under the Effects tab select Chroma Key from the Effects dropdown list. The input numbers currently assigned for the
background (BG) key subject (CK) are displayed on the icon. Change those in the dropdown lists to use the desired inputs.
You can also select a File to use as the background by clicking on the File: icon and locating an image. You’ll see the
changes in the Preview window in real-time. If you want to refine the key, click the Setup button.
Setting up a Chroma Key follows the same procedures as PIP/DVE effects. Choose your Foreground Input (the object in
front of the Chroma Key screen) … and your Background Input, which can be a video input or a selected graphic file.
Then click the Adjust Chroma Key
button. This setup window will
appear, with the Foreground Input
displayed. These faders control the
most important values in creating a
good key: Power, Transparent, Color
and Smooth. Press the Auto Detect
button and the current settings for
these controls will be applied to the
key, with the crosshatch pattern
representing what the selected
Background input or graphic will fill. If
you check the Apply Instantly box, the
adjustments you make will appear on
this screen AND in the PREVIEW window of VDESK/REMO. Click the Advanced
settings plus sign to extend the number and levels of control for creating the best key. Click the Apply button to see your
changes, or check the Apply instantly checkbox to see the changes as you make adjustments. When you’re satisfied with
your key, close this window, and click the TAKE or AUTO button to display the Chroma Key on the Program output.
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Setting up a Recording
Recording on VDESK is very simple. The settings panel in the bottom right of the screen has an "Encode" section. If you
click on that tab, this screen will appear:
The file path defaults to the "Recordings" folder on the D drive, and you can
chose if you want to enter a File Name. If you do, that name will be included at
the beginning of the file name. If not, the file name will begin with “Filename”,
followed by the date and time in YYYY-MM-DD_HH-MM-SS format when you
started the recording.
Below the File Name field, select (click to highlight) format(s) you want to
encode. MPG is MPEG-2 CBR 8Mbps. AVI is DV-25 with PCM audio, and WMV
creates a Windows Media file. You can select MPG + WMV or AVI + WMV since
the program supports simultaneous encoding of all these formats.
To start recording, click RECORD. Whatever you see on
the PROGRAM display is what you are recording.
You will see separate information displays for
each encode-in-progress. You can click the PAUSE button at
any time, and it will glow bright yellow – with the button label
now displaying RESUME. Click the RESUME button and the
file(s) will resume encoding, creating contiguous seamless
contiguous file data.

Adjusting System Configuration
To adjust System Configuration parameters, right-click on the title bar for any of the
cameras and choose Configure… or click on the Configuration button on the VDESK panel.
If you need help with any of these
settings please contact RUSHWORKS
support at 888.894.7874 x2
On the CAMERAS page you can
configure your PTZ cameras. Doubleclick the line corresponding to the
camera number you want to set up and
choose your camera type, the com port
it is connected to, and the baud rate.
System wide camera settings are also available for Allow On-Air Go To Preset, Smooth On-Air Go To Preset, and Recall
Preset AE Reference. See the table below for descriptions of these.
Allow On-Air Go To Preset: Allows selecting a preset position for the current program camera. When this is not checked
any presets clicked for the on-air camera will be ignored. This setting is enabled by default.
Smooth On-Air Go To Preset: Any on air preset selections will result in an attempted smooth camera move by the
software. Not all cameras perform adequately on all types of moves, so please test before using this feature live. This
setting is enabled by default.
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Recall Preset AE Reference: When checked, recalls the individual preset's AE reference setting. When unchecked the AE
reference is used as a universal setting for each camera.
The Routers page has been preconfigured so do not change any settings here.
If you have trouble with the joystick refer to the
calibration page first, then check this JOYSTICK
page. With the joystick centered click the "Center"
button to correct any wandering the cameras might
be doing. You can also customize the buttons and
invert the axis of the controls.
There are defaults for six (6) different
makes/models of joysticks. Click one if it matches
the joystick you have.
Note: VDESK, REMO and Ctrl+R systems currently
include the APEM 6 button Hall effect joystick.

The HARDWARE page has also been preconfigured. Changing these options could result in severe problems with the
system. Please contact RUSHWORKS Support before making critical system configuration changes. We’re here to help!

Configure CRAWL parameters
There are two fully independent crawl layers. You can configure the
appearance of each by changing font (size, style and color),
determining their position on the screen, the background color and the
speed.
Select Crawl: Use the drop-down to select Main or Auxiliary.
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Text Font: Click the Choose … button to open the typical
system font selection window:
Offset from Top: Enter a number that represents a
percentage (%) down from the top of the screen.
Crawl Speed: The default is 2. Experiment to see what
speeds you like relative to the font type and size you specify.
Background Banner: If the checkbox is checked, you can specify the Banner Height as a
percentage of the Font Size; the Banner Color (by clicking the Choose... button to open a color
palette), and the Opacity (transparency) of the banner.
Optional Message Separator: Use Text to separate multi-line messages – or Insert a “bullet” (•) between multi-line
messages, or Use Graphic to place a small logo or other picture between messages.
Message Spacing: enter the number of spaces you would like to see between multi-line messages.

Monitoring & Controlling Audio Levels
In the upper right of your monitor you will see a real time indication of your main audio
output. This is also the level that your recorded audio will be at.
Digital systems such as this are designed with -12dBFS as the optimal peak level. You will see
the red OVER indicators light up if you go too far over this level. When they light up you will
most likely experience audio clipping in your output and recording. If you wish to clear the red
indicators simply right-click them.
If your levels are too high or low, all you have to do is move the slider up or down to
compensate. It is a good idea to test your LIVE input levels against your CLIP playback levels
before your production begins. This can be done on the AUDIO panel.

VDESK / REMO - User Guide Version 6.3 - 2018

Page 23

Working with Dynamic Auto Zoom
Dynamic Auto Zoom provides you with several parameters that bring motion into otherwise
static preset shots. This feature is available with RUSHWORKS’ VDESK, REMO and Ctrl+R
Integrated PTZ/PTX Control Systems, which support up to 12 remote camera inputs and control
windows.
Click the D.A.Z. SETUP button, check the
Enable Dynamic Auto Zoom box, and
select the behavior you wish. It uses the
actual preset position you’ve named and
saved as the start point.
From there you can Zoom In, Zoom Out, or
Zoom In and Out ... with the option to
Reverse at End.
You can specify the Delay before Zoom, the Zoom Speed, the Zoom Duration,
and the Delay before Reverse if you’ve activated that checkbox.

You can even set up a Continuous Loop so the Zoom is always in effect when you take
the shot. You can save the parameters to All your PTZ cameras if you wish.

When active, the DAZ button is bright blue. When not active, the DAZ control on the
camera panel is light gray.
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Starting your Production
Once you have prepared your system for the production, review this list to make sure you are ready.
1.

Are all your camera presets set for this venue?

2.

Are the lower thirds and title screens ready and in your playlist?

3.

Are the lower thirds linked to the correct camera presets?

4.

Is your playlist saved?

5.

Is your layout (which includes camera presets) saved?

6.

Did you check your audio levels?

7.

Did you specify a file path for your recording?

8.

Do you have enough available record time for your program?

9.

Did you select the correct recording format?

10. Did you name your file?
If everything is done, you’re ready to begin!

Don’t forget to start recording!
The first thing to remember when you are ready to start your production is to
CLICK THE RECORD BUTTON!
The steps you take from this point on can vary greatly, but
let's take a look at a typical city council meeting as an
example.
1) Enter a File Name for the Event you are recording.
2) Select MPEG-2 or H.264 as the recording format.
3) Verify the Bit Rate you want to use. The default for HD is
35Mbit/sec. You can select between 12 and 50 Mbit/sec.
4) Click the RECORD button to start recording.
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Select opening animation in the playlist.

Touch AUTO on the switcher to fade up and play the intro.

Click a preset for a Wide establishing shot of the venue. If HOT SHOT AUTO/TAKE is active, the
Wide shot will automatically go to air when the preset is reached.

Cut to main speaker, in this case the Mayor.

Fade ON the graphic “lower third”.
(if it was linked to the shot it loaded automatically)

Fade out the graphic.

Pick a new shot, follow the action and repeat!
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Adobe Elements and VDESK / REMO
For your convenience, VDESK and REMO systems include Adobe Photoshop and Premiere Elements. For extensive guides
please refer to each product's manual, or to Adobe's website. There are many useful video tutorials to help you through
all the different features of each program. Just select a product to see any of the available videos.
These programs are great for creating graphics of all kinds, including lower-third titles with transparency (PNG). You can
also edit your productions, or any other production footage … so this added functionality provides you with enhanced
capabilities on your VDESK/REMO system.
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Using the PRODUCER Interface
USER GUIDE

(Features and functions are being added continually, and this Guide will be updated frequently. As a result, the content herein may not reflect the current
feature set and behavior of the application)

PRODUCER Overview: Staging an Event
While the CLASSIC user interface is easy to use, the unique design of the PRODUCER touch screen user interface provides
the simplest, most intuitive multi-camera production mode available. It’s based on creating and producing “Events” using
a virtual on-screen 3D simulation of the physical environment where the PTZ cameras are located for each Event.
Example locations include a meeting room, house of worship,
radio station control room, indoor theatre, outdoor stage, or
any other multi-camera production venue.
The exclusive DoubleTake™ function lets you create an
unlimited number of presets using a single PTZ camera,
automatically assigning those presets – with lens offsets – to a
second camera, and go to any preset with either camera for
instant coverage of any venue using just TWO PTZ CAMERAS.

You create the Event layout using five setup tabs: STAGE, CAST,
PLACES, CAMERAS and PRESETS. Once the STAGE is set, you
select shots by simply touching the picture or icon that
represents the person or object at that physical place in the
venue.

For meetings these are typically pictures of meeting participants (picture icons =
picons) in their respective seating positions. For houses of worship and theatrical
events these are often a combination of picons and ‘musical icons’ (musicons™) such
as a piano, guitar, drums, singers (tenor, soprano, etc.).
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In addition to simple ‘touch/take’ production, you can display a branding logo (aka “bug”), two crawls, an animated
‘snipe’, graphics and text. Select any or all of these graphics options on the PROGRAM monitor bezel at any time.

To change from the CLASSIC interface to the
PRODUCER interface or the TalkingPoints interface,
click the Configuration button, select the HARDWARE
tab, and click the radio button for the Interface radio
button you wish to use. The program will automatically
close, then reopen with the interface you’ve selected.

The STAGE tab
Click the File menu and select New Event. This opens a Save dialog
where you will name and save the Event into an Event sub-folder.
Click the Stage Setup button … then click the STAGE tab. There are
several STAGE background templates to choose from, including the
one(s) customized for your venue(s) prior to delivery of your
VDESK/REMO system. Select the one that best represents your
production environment.
Select your STAGE file by right clicking the browse button to open the
STAGES folder. Here you’ll see large icon views of the STAGE
background templates, organized into sub-folders for DAIS, HOW
(House of Worship) NEWS, THEATRICAL and CUSTOM. There is an
EMPTY.png you can use if you don’t want to use a graphic for the
STAGE.

Double-click the file (or select and click Open) that best
represents your production venue. That layout will
appear on the STAGE screen.
Note: if you want to create your own custom
background, use any graphics program to design
it and save it as a JPG, BMP or PNG file and place
it in the STAGE LAYOUTS folder. We’ve included
an empty stage to use as a background for
custom designs. If you wish to make a
VDESK
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The CAST tab
Next click the CAST tab. Here you will:
1. Assign a picture icon (picon) for each preset
2. Enter a Name and Title
3. Select a graphic banner background for the
name and title
4. Enable “over the shoulder” (OTS) presets for
the CAST member. These are typically used in a news-style presentation where the camera pans slightly left or
right to allow for positioning of a graphic on screen with the person in the shot.

Click the Add New button … and the associated entry fields will appear. In the NAME and TITLE fields enter the Name and
Title of the CAST member (e.g. Roger Thomson and Council Member – or St. Anthony Chancel Choir and Sopranos).

To the right of the BANNER field click the File browse button to open the BANNERS folder. There are several banner
templates to choose from. Select the graphic background you want to use behind the Name and Title display.

NOTE: these will automatically be composited into files that are linked to each CAST member preset for manual or automatic display
when the preset is touched/selected.

Under PORTRAIT, click on the silhouette button of the CAST
member. This will open the PORTRAITS folder within your
currently open Event where you store pictures of Event
participants. Double click on the picture you want to use – or
select the picture and click Open. The picture will replace the
silhouette. If you work with multiple Events (e.g. COUNCIL,
P&Z, etc.) there will be a unique PORTRAITS sub-folder within
the saved and named Event sub-folder.
NOTE: The PRODUCER interface allows you to capture
pictures for CAST members using any of the PTZ
cameras configured with the system. If you want to
create pictures in that manner, don’t click the
silhouette under PORTRAITS when you’re defining
CAST members. When you create your presets on
the PRESETS tab you can capture a picture with your
PTZ camera that will be associated with the already
created CAST member. It will place the capture in the
PORTRAITS sub-folder with the appropriate name,
and also display it in the CAST tab whenever opened.
To add another CAST member, just click the Add New button beneath the last added member. Follow the procedures
described above until all the CAST members are defined, then click the SAVE button to save your information but not
close the Stage Setup panel. Click Close button to close the Stage Setup panel if you don’t want to do additional entry or
modification using the Stage Setup tabs.
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The PLACES tab
Once all the CAST members have been defined, click the
PLACES tab.
All the defined CAST member picons will be displayed
across the top of the STAGE layout in the order in which
they were created. Select each picon and drag it to its appropriate place
on the STAGE.

Changing the SIZE of display picons
You can choose from three (3) display sizes: Small, Medium and Large.
The default size is small. To change the size of ALL the picons on the
STAGE: double-click anywhere on the STAGE and they will all be
selected, as indicated by a red outline on each picon. Then click another
SIZE radio button and they will all display in the selected size.

To change the size of individual picons on the STAGE: click once on any
picon to select it, as indicated by a red outline. Then click another SIZE
radio button and only that picon will display in the selected size.

Adding EXTRAS to the
STAGE layout
“EXTRAS” are defined as presets without unique pictures, names, titles or
banners. These are typically used in theatrical and/or musical presentations
and for houses of worship.
We’ve created a folder with dozens of icons that are representative of these
types of presets, including musical instrument and performer icons
(musicons) as shown here.
In the PLACES tab, click the Add Extras button. A folder will open, revealing all the Extras picons. Just double-click a picon
to place it on the STAGE … or select it and click Open. To add multiple EXTRA
icons, hold down the CTRL button and right-click on the ones you want to
add, then click Open.
As you select Extras they will display horizontally across the top of the STAGE
layout. You can then drag them to their appropriate position(s) on the
STAGE.
To REMOVE an Extra picon, just select it and click the Remove Selected Extra
button. It will disappear from the STAGE layout.
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The CAMERAS tab
The system recognizes how many PTZ cameras are configured (via RS-422 or IP) when the
program is started. When you click the CAMERAS tab, you see the STAGE layout with CAST
members and extras … and a row of configured PTZ camera icons at the bottom left of the
STAGE layout. Drag each camera to its relative position on the STAGE. This establishes the
association of the physical camera location relative to the CAST
members and Extras.
You can mix “manned” cameras (non-PTZ) and PTZ cameras. They
will display on video input windows and can be selected on PVW
or PGM by using the F keys F1 – F8 (PGM), keyboard number keys
1-8 (PVW) or shortcut keys on the keypad. F9 and key 9 always
select BLACK on PGM and PVW, respectively, on the switcher. The
joystick will always control a PTZ camera that is currently selected
on the PREVIEW bus.

The PRESETS tab
After you’ve selected your STAGE background, defined the CAST
members, dragged the picons to their PLACES, and positioned
the configured cameras, you’re ready to create PRESETS for each
of the CAST members on the stage … as well as for any EXTRAS
you may have placed. Additionally, you can create random
presets that are associated with the QUICKSHOT buttons at the
bottom of the screen.

To create a preset for a CAST member or
EXTRA …

Click once on the camera (icon) you want to
associate with the shot. That camera will
highlight RED. Then click the CAST member or
EXTRA on the STAGE. The PRESET camera
window will open and the selected camera’s
output video will be displayed.
Using the joystick (or the PTZ buttons on the
PRESETS camera window), frame the shot the
way you want it stored. You can also capture
the framed shot as the graphic to use as the
Portrait in the CAST tab and for picon screen
display.
Click the Capture and Update button to save and store the snapshot as the Portrait for that CAST member. Click the Save
Preset button to store the preset. Click the Close button at any time to close the PRESET window.
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Enabling and Using DoubleTake™
The DoubleTake function lets you create an unlimited number of
presets that are duplicated between two PTZ cameras which are
mounted closely together – either horizontally or vertically mounted
– with a minimum of distance between the lenses.
On a 4-input system you can create TWO pairs of DoubleTake
cameras (1-2 and 3-4). On an 8-input system you can create FOUR
pairs of DoubleTake cameras (5-6 and 7-8).
The example on the right illustrates the type of ‘blanket’ coverage you can achieve with DoubleTake camera pairs.
Typically there would be one pair of DoubleTake cameras at the rear of a room venue, and another pair on the wall
behind a dais at the other end of the room for maximum coverage of the venue.
For example, using Camera 1 to create all your presets for a 1-2 DoubleTake pair, the program automatically saves all the
defined presets to Camera 2 as well, calculating the offset in the X and Y
(horizontal and vertical) axes between the two cameras. It also stores the same Z
(zoom) value, which means that either camera can go to any preset you’ve
created. There is no limitation on the number of presets you can create for any
camera.
This mode follows standard Preview/Program switcher protocol, with each of the
cameras always displaying on either Preview or Program bus of the software
switcher. The camera currently on the Program bus is outlined in RED … while the
other camera is outlined in GREEN.
To display the cameras properly and enable this mode, on the CAMERAS tab drag
Camera 1 to the position where it and Camera 2 will be located next to each other.
Then click the Enable Camera 1-2 DoubleTake checkbox. The Camera 2 icon will
automatically jump to the immediate right of the Camera 1 icon.
The above image shows the PREVIEW (Green) /
PROGRAM (Red) relationship between the
DoubleTake camera pair, the camera video
monitor windows and the STAGE picons.

Setting up the DoubleTake offset
If you’ve checked the Enable Camera 1-2 DoubleTake checkbox on the
CAMERAS tab, you’ll always use the lowest number in the pair to set
your presets for the two cameras. With a single pair of DoubleTake
cameras, you’ll always use Camera 1.
NOTE: When you click Camera 1 or 2, they will BOTH turn RED,
indicating they are a DoubleTake pair. If you enable a second pair
of DoubleTake cameras, they will be Camera 3 and 4. So you’ll
always use Camera 3 to set presets for that pair.

With the DoubleTake checkbox checked, click on Camera 1,
and then click on a CAST member or EXTRA. The PRESET
camera window will open and the selected camera will
move to its “Home” pan-tilt-zoom position (presuming you
have not already created any presets).
NOTE: It’s best to choose a CAST member or EXTRA in the middle of the STAGE when you’re setting up the secondary
camera offset. This is generally a one-time-only exercise so you’ll want to trim the offset to a single area of the stage. The
Horizontal and Vertical offset will be applied to the secondary camera for ALL presets on the STAGE.
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Using the joystick (or the PTZ buttons on the PRESETS camera window), frame your shot then click the ALIGN button on
the camera window. The window will expand to reveal a second camera window which displays the DOUBLETAKE
Camera.
Between the two camera windows are the OFFSET adjustment fields. If the cameras are mounted sided by side, the
largest offset will be Horizontal … or Vertical if mounted one above the other.
Entering a negative value (-) for the Horizontal results in panning the camera to the right. In general, if you start by
entering a value of -60 (and click Apply) you’ll see the DoubleTake camera move to a position similar to that of the
PRIMARY camera. You can also use the up/down arrows to the right of the value to create the offset value(s). Whenever
you change the value, the Apply button will display YELLOW until it is
Click Camera 1 and 2 buttons to VIEW ON
clicked.
PROGRAM OUT to verify closest alignment
You can monitor the output of both cameras on the PROGRAM OUT of VDESK
or REMO to verify the closest trimmed alignment. Just click the 1 and 2
buttons to see the cameras switch on the PROGRAM OUT. That’s the best way
to verify optimal alignment.

Vertical positive
numbers tilt the
camera UP
Horizontal negative
numbers pan the
camera RIGHT

NOTE: These OFFSET parameters are Global … meaning that they apply to ALL
presets on the STAGE that were created by a set of DoubleTake cameras.
Because of different angles relative to the two cameras, some DoubleTake
preset offsets will be more accurate than others. In general, if you frame the
tightest shots as Medium Close Ups (MCU), you’ll be happy with the results. The wider the shot, the less offset you’ll see
between the two cameras.

Saving PRESETS to the QUICKSHOT Button Bar
Below the STAGE area are twelve (12) large red buttons.
These are used for “general purpose” presets that are often
convenient to have, but which don’t correspond directly to
a CAST member or other picons on the STAGE. These are
called QUICKSHOT buttons.
To name and save a PRESET to a QUICKSHOT button …
select the PTZ camera you want to use for the shot, then
use the joystick to position the camera where you wish.
Right-click a QUICK SHOT button and a drop-down menu will
appear. Choose the option that applies to what you want to
accomplish. Typically you will Save and Name the shot you
currently have framed in either the PREVIEW or PROGRAM
window.
When you select either of those options, the Name and
Save dialog box will open where you can enter a name for
the preset. When you click OK, the window closes, and
you’ll see that name displayed on the QUICKSHOT button.
Selecting any of these shots follows the same rules as
presets associated with picons. You can switch between and
among CAST picons, EXTRAS and QUICK SHOTS whenever
you wish.
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Switcher Functions on the QUICKSHOT Button Bar
On the right side of the QUICKSHOT button bar are additional buttons for
controlling select functions on the PRODUCER interface
Click AUTO or TAKE to initiate the currently assigned transition between
the PREVIEW and PROGRAM busses.
Click MASTER FADE to take all current sources, DSK overlay, graphics
overlays and audio to BLACK. While in this state, the button will flash once
every second to remind you that you need to click it again to resume your
PROGRAM output.
Click SHOW/HIDE SWX and PVW to display the ‘floating’ switcher panel
and/or PREVIEW windows. just above the button bar. The switcher is
necessary for specifying Transitions and Effects.

Showing the SWITCHER and PREVIEW Windows
The PRODUCER interface is an alternate to the CLASSIC
interface, supporting a unique and simple touch screen
production style. But since both interfaces are built on the same
programming platform, you have access to most of the
same features and functions in the CLASSIC presentation.
To display the SWITCHER panel, just click the SHOW SWX
button on the QUICKSHOT button bar. To display the
PREVIEW monitor, click the SHOW PVW button. These
buttons toggle to HIDE SWX and HIDE PVW when
pressed. All the display panels are movable, so you can
‘float’ the SWITCHER and PVW panels and all other visible
panels wherever you wish, even making a custom
arrangement using a second monitor.
You’ll need to display the SWITCHER panel in order to
access the Transitions and Effects tabs where you can
select different types of transitions, use the T-Bar, and set
up DVE and Chroma Key effects.

Showing the AUDIO MIXER
To display and use the AUDIO MIXER, click the
SHOW MIXER down-arrow beneath the Master
Audio Fader. The Mixer window will open,
where you can control the levels of the LIVE
input, CLIP1 and CLIP2 and the SNIPE audio
level (if the Snipe AVI file contains audio).
When it is visible, you can place it anywhere on
the screen … or on a secondary monitor if one
is connected.
To close the AUDIO MIXER, click the HIDE
MIXER up-arrow.

Using the DSK control
The DSK control in PRODUCER is a simplified version of the one in the CLASSIC interface. In either the File Browser or a
Playlist, click on any file with transparency (PNG) … typically a lower-third graphic … and it will load into the DSK window.
VDESK / REMO - User Guide Version 6.3 - 2018

Page 35

To display the file over the current PROGRAM selection, just click the DSK button. The
graphic will fade on and the DSK button will glow bright blue, and the ON-AIR sign will
illuminate. Click the button again to fade off the image.
When an image is being displayed on the PROGRAM output, you cannot load another
graphic until you’ve faded off the DSK graphic.
The following sections are included on pages in the CLASSIC section of the USER
GUIDE:

Selecting Transitions
Selecting and Using Effects
To display a Picture in Picture …
To display a Double Box (PiP …
Working with Chroma Key

RUSHWORKS Contact & Support Info
VDESK and REMO are technology innovations from RUSHWORKS

Software and Graphic User Interface Design
© 2001 - 2018 RUSHWORKS, All Rights Reserved
www.RUSHWORKS.tv

SUPPORT AND TECHNICAL ASSISTANCE FOR RUSHWORKS SYSTEMS ARE AVAILABLE VIA EMAIL,
TELEPHONE OR SKYPE.
support@RUSHWORKS.tv

888.894.7874 option 2
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